Physics 244 College Physics I Lab  
Summer 2010, Room 228 and 324 Science & Technology I

Section (MTR): 3:30 PM-6:15 PM: 2A3
Instructor: Jason Lee
E-mail: je@gmu.edu

Note: All email communication to and from the instructor concerning this course will be to
GMU accounts only. Make sure your account is activated.

Text: Physics 244 Lab Manual, Summer 2010, available on line.
Website: http://physics.gmu.edu/~jlieb/phys244

Tentative Schedule:

May 17       Measurement Uncertainties (228)
May 20       Free Fall (228)
May 24       Projectile Motion (324)
May 25       Newton’s Laws (Discovery) (228)
May 27       Conservation of Energy (228)
May 31       Memorial Day – no lab
June 1       Conservation of Linear Momentum (Discovery) (228)
June 3       Angular Motion (228)
June 7       Torque (228)
June 8       Simple Harmonic Motion (228)
June 10      Standing Waves on a String (Discovery) (228)
June 14      Ideal Gas Law and Heat Engine (228)
June 15      Final Examination (228)

You must download and read copies of the lab handout prior to the lab.
Grade Determination
There are 11 laboratories scheduled and you are expected to perform a minimum of 10 experiments and to write a minimum of 7 formal lab reports. The three experiments designated as discovery laboratories do not normally require a formal lab report; however, a student who misses several of the formal report laboratories must ask permission to write a report on one or more of the discovery labs in order to meet the 7 report minimum.

The numeric grade will be calculated according to the following formula:

\[
\text{Numeric Grade} = 0.78 \times \text{Report Average} \times (N/10) + 0.22 \times \text{EXAM} \pm \text{Discovery Points}
\]

Report Average = average of the best 7 of 8 formal lab reports
N = number of laboratories performed but N can not exceed 10.
EXAM = exam grade percent
Discovery Points are assigned to the two discovery labs as follows
- Outstanding +1/2
- Satisfactory 0
- Unsatisfactory -1/2

The inclusion of the three discovery experiments which are marked on the schedule is designed to reduce the number of formal lab reports while at the same time allowing students some experience in exercising their creativity in lab design. The above formula is designed to make the three discovery experiments have a relatively minor impact on the student’s course grade for those who perform them.

The laboratories designated as discovery will be conducted as follows
- Very short lecture.
- Instructor will only offer advice on technical matters.
- Instructor will ask questions of each group as the experiment progresses.
- Each group will submit a collection of data tables, graphs and consensus conclusion at the end of the period.
- Individual students may also submit supplemental conclusions at the start of the next period and it is important that they do so if they disagree with the group conclusion.
- Groups that follow the lab manual are likely to receive a satisfactory grade but no discovery points.
- Groups who work out their own techniques are more likely to gain or lose discovery points.
- The discovery points awarded will be based on observations made by the instructor during the experiment as well as the data and graphs submitted and the group and individual conclusions.
- No formal report is required.
- A student who has missed several laboratory sessions may write a formal report on a discovery experiment in order to maximize his or her RA (report average) which requires 7 formal reports.

About half of the exam will cover treatment of uncertainties and the other half will cover questions about particular experiments. There may also be a short exercise or written questions about working with Excel or DataStudio.
**Requirements for Course:**

You must be taking PHYS 243 concurrently or have completed it. It is expected that all students have a thorough understanding of algebra and basic graphing techniques. A basic knowledge of Excel is a plus. Lab reports are expected to be computer generated so a word processing package should be available to you. The campus has many computer rooms available over a wide range of hours.

**Goals for Course:**

1. To enhance material covered in the main course by exposing students to the actual testing of the theories and equations discussed in lecture.
2. To teach students the basic techniques of computerized data acquisition and analysis.
3. To help students become more experienced in the written presentation of scientific data.
4. To give students a good understanding of experimental uncertainty and how it propagates through calculations.

**General Information:**

Experiments will be performed as shown on the lab syllabus but it may be necessary to modify the schedule. All labs will include an introductory lecture followed by completion of the laboratory assignment. The introductory lecture reviews concepts covered in Physics 243 relevant to the experiment, the specifics of equipment used, and the required data analysis. Students will not leave the lab room other than to go to the rest room without permission from the instructor. Before you leave lab, you must request that the instructor review your data and sign it. Signed raw data sheets are required to be attached to reports when they are submitted.

All labs are due at the start of the next lab session after they are performed unless you are told otherwise by the instructor. Any late labs will be penalized (see lab reports). Please contact the instructor before the lab date if you know you will not be able to attend a session. Since this lab is performed other times during the week, you may be able to attend another session. This is only in extreme cases and subject to prior approval of both your instructor and the instructor who teaches the lab session you wish to attend. Do not show up to a lab session you are not assigned to without prior approval.

If special instruction is needed or questions arise about a lab, it is the student's responsibility to seek help from the instructor before the due date. Your instructor will announce office hours and may be available at other times.

**Lab Groups:**

Students will usually work in groups consisting of 2 or 3 students. All members of a group should be involved in conducting each lab experiment. Computers will be used for data acquisition and analysis in most experiments. Students should take turns working on the computer so that everyone gains the same experience working with Excel and the data acquisition system.
Lab Reports:

All students are required to submit a report for each experiment except the discovery labs. This report must be an individual effort that reflects the student’s understanding of the experiment. **Plagiarism is a violation of the honor code.** Since students will work together in lab, it is important to understand what permissible group work is and what must be done individually. In taking data, each student may perform a different role but everyone must participate in performing each part of the experiment. You may not report on parts of an experiment that you did not actively participate in. Usually one person will enter data into the computer and all students may use computer calculations and graphs done in lab. All work done outside of lab must be done individually.

Work that must be done individually includes the introduction, conclusion, uncertainty calculations and discussion of uncertainties. Students may discuss these sections with their lab partners but the work must be done individually and copying of anything is strictly forbidden. Any two reports which have identical sentences or have paragraphs with identical structure will be considered to be plagiarized.

Reports will be turned into the instructor at the start of the next scheduled lab session. Reports not handed in at that time will be late and will be penalized 10%. Students are cautioned that you will not be permitted to print out a final copy of a lab report on the day it is due. All reports should be printed and stapled when you walk in the door. Late lab reports will have 10% per lab session deducted from the grade. On very rare occasions, students with a good excuse may be permitted to turn in late work without penalty as long as they obtain the lab instructor’s permission prior to the due date. Normally this permission will only be granted once. The best way to request such permission is by e-mail.

Preparation for class

Students must download the handout for each experiment prior to class and you may not use lab computers to download the handout without specific permission of the instructor. You are also expected to briefly read over the handout before class.

Pre-Lab Lecture:

There is an introductory lecture at the beginning of each lab. It is expected that all students arrive on time and not miss any portion of this lecture. After the lecture, students work in their groups and conduct the experiment scheduled for that day. Students are encouraged to finish most of their calculations and error analysis in the lab. All students are required to have the instructor initial their data sheet before leaving the lab for the day. Since the introductory lecture is a necessary part of the lab session, students who arrive more than 10 minutes late or are consistently late will be penalized 5% on that lab report. Students who miss too much of the lecture will not be permitted to do the experiment.

Computers may not be used for any purpose until the lecture is over. At no time may they be used for reading e-mail or web surfing. After lab, you may e-mail your results to your account or save them on a memory stick.
Lab Report Format

Each member of a group must submit a laboratory report typed (i.e. computer printout) in his or her own words. Please write on only one side of the page. Please don’t use any fancy binders and please staple the report in the upper left hand corner. Please keep your report as short as possible and I may establish a limit on the number of words on some of the later reports. There is no specific grade for participation but I will deduct points from the lab report grade if I observe that a student is not doing his or her share of the work. The basic format of a report is as follows:

1. Title page  
   Includes:
   1. Name (upper right corner)  
   2. Experiment title and number (upper right corner)  
   3. Course Name  (lower part of page)  
   4. Lab partner's names (lower part of page)  
   5. Date report was submitted (lower part of page)  
   6. Instructor's name (lower part of page)  
   8. Table number  
   9. Word Count

2. Introduction  
   State the purpose of the experiment and briefly describe the procedure used to conduct this experiment. Include a rough sketch of the setup. The introduction should include important equations and define symbols and units.

3. Results and Discussion  
   Present all data collected in the experiment including graphs and spreadsheets. 
   Explain the sources of uncertainties in your experiment and your estimate of the size of each uncertainty. Discuss any significant problems you encountered and how you resolved these problems. You should use your data, graphs and calculations to support your conclusion about the results obtained in the experiment. Discuss each graph in detail: tell what was expected, why it was expected (a reference to a theory or equation that is being tested) and what was observed. Number your tables and graphs in a consistent manner so that you may refer to them more easily in your conclusion.

4. Conclusion/Summary  
   Summarize the results and tell whether there was agreement between theory and experiment. The agreement or disagreement between the experimental and the accepted value of a quantity should be expressed as a multiple of sigma. If possible you should suggest ways of improving the experiment.

   *NOTE: It is generally better to put your detailed analysis of the results with the graphs in the results and discussion section and let the conclusion section summarize everything. Do NOT include the same information in each section—it should appear only ONCE in the report.

5. Sample Calculation with uncertainty propagation.  
   Include a sample of each type of calculation performed in the lab including propagation of uncertainties with sufficient details to enable the grader to evaluate your work. Sample calculations should be done by hand. The sample problems in the uncertainly part of the lab manual are a good guide to the format for sample calculations.
**Some Tips for Lab Reports**

In writing your report your goal should be to cover everything that is required in as few words as possible. Some students include “extras” in hopes of enhancing their grade but this is usually a waste of time. Examples of extra material that will not result in a better grade are details of the life of the scientist that did the work, derivations of the equations, history of the development of the theory, applications of the technology, discussions of how much you enjoyed or didn’t enjoy doing the experiment, describing how hard it was to make the measurements or how you initially made a mistake and wasted time.

You should discuss the sources of major contributors to the uncertainty of measurements but don’t simply give a laundry list of possible uncertainties with no indication of the magnitude of each contribution to the overall uncertainty.

1. Your report should be aimed at a reader who knows physics but who was not in the laboratory on the day you did the experiment. So you should provide sufficient information for such a knowledgeable reader to interpret you work.

2. In Microsoft Word and Excel it is very easy to insert symbols such as ±, θ, and σ. Use the pull down menu ‘Insert > Symbol’.

3. In Microsoft Word you can make superscripts and subscripts (\(x^2\) or \(x_2\)) using the pull down ‘format>font’ or you can add icons to the toolbars for these operations.

4. To add an equation to the report use the pull down ‘Insert> Object> Microsoft Equation 3.0’.

5. Assign a number, roman numeral or letter to each Table, Figure, or Graph and use this to reference them (i.e. “see Table II” or “refer to Graph C”).

6. Always round numbers to an appropriate number of significant figures.

7. A well designed table provides an excellent way to present the results of an experimental measurement. The following table shows fictional data for a measurement of the acceleration due to gravity using a pendulum where the length of the pendulum and the mass of the pendulum bob has been varied and g is calculated from the formula \(g = 4\pi^2 \frac{L}{T^2}\). \(T\) is the period of the pendulum (the time for one full swing back and forth). Since the mass of the pendulum bob does not enter the equation, changing the mass should have no effect.

<table>
<thead>
<tr>
<th>Length (m)</th>
<th>Mass (kg)</th>
<th>Period (s)</th>
<th>(g_{\text{exp}}) (m/s(^2))</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.50 ± 0.02</td>
<td>0.25 ± 0.01</td>
<td>1.43 ± 0.02</td>
<td>9.7 ± 0.5</td>
</tr>
<tr>
<td>0.50 ± 0.02</td>
<td>0.50 ± 0.01</td>
<td>1.42 ± 0.02</td>
<td>9.8 ± 0.5</td>
</tr>
<tr>
<td>0.50 ± 0.02</td>
<td>0.75 ± 0.01</td>
<td>1.41 ± 0.02</td>
<td>9.9 ± 0.5</td>
</tr>
<tr>
<td>0.50 ± 0.02</td>
<td>0.75 ± 0.01</td>
<td>1.40 ± 0.02</td>
<td>10.1 ± 0.5</td>
</tr>
<tr>
<td>0.75 ± 0.02</td>
<td>0.75 ± 0.01</td>
<td>1.75 ± 0.03</td>
<td>9.7 ± 0.4</td>
</tr>
<tr>
<td>1.00 ± 0.02</td>
<td>0.75 ± 0.01</td>
<td>2.01 ± 0.04</td>
<td>9.8 ± 0.4</td>
</tr>
</tbody>
</table>
Notice how the organization of the table allows a critical evaluation of the data. For example, the first three rows show data in which the mass is systematically increased and this makes it easier to see that $g_{\text{exp}}$ also appears to increase. A careful consideration of the size of the uncertainties suggests that this increase is probably not real but it is a question that should be examined in the discussion. Although the theory predicts that there should be no dependence on mass, it is not unreasonable to think that air resistance may have less of an effect on a heavier mass. It should be noted that the uncertainty in each measurement is included in the table as well as the appropriate units.

8. In Microsoft Word, if you wish to generate a new table within the results section of your report, first make sure that you do not already have the information on a printout that you made during lab. (If you plan to replace the lab printout, that is fine—the goal is not to include redundant information.) Then, go to ‘Table > Insert > Table’ and specify the dimensions of the table. After you have initially set the number of columns and rows, the width and height of the table may be adjusted in the document using the cursor.

9. If you forget to put some information on a table or graph, no credit will be lost if you write it in by hand.

10. When printing in lab, please set all graphs to have a white background in order to save toner.

11. On discovery labs, it is important to remember that plotting data is usually the best way to understand the data, to check it for consistency, to analyze it, to present the data to the reader, and to draw conclusions from it. One must make decisions as to exactly what to plot, what type of scales to use (log, semi-log, linear), and so on, so as to best accomplish the above ends.

12. The proper units must be included with all measurements.